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1 Over deze cursussite

1.1 Over deze cursus

Welkom bij de cursussite voor de practica van Teledetectie 2024. Deze cursus is ontworpen om studenten de
basisprincipes aan te leren van het verkrijgen, voorverwerken, analyseren en exporteren van remote sensing data.

1.1.1 Topics die aan bod komen:

Practicum 1: Downloaden en beeldinterpretatie

Practicum 2: Introductie Google Earth Engine

Practicum 3: Feature extractie

Practicum 4: Beeldclassificatie

Practicum 5: Tijdserieanalyse

Practicum 6: Introductie tot Synthetic Aperture Radar (SAR)

Practicum 7: Introductie tot GEDI
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Deze cursussite is zo ingericht dat je eenvoudig stukjes script kunt kopiëren, waardoor je snel aan de slag kunt. In de
tutorials leer je bepaalde functionaliteiten kennen door het copy-pasten van voorbeeldscripts. In de daaropvolgende
oefeningen zul je deze tools zelf moeten toepassen.

Gedurende de practica wordt deze site regelmatig aangevuld met nieuwe documentatie, extra informatie en
antwoorden op veelgestelde vragen.

1.2 Afdrukbare PDF's

Voor degenen die de voorkeur geven aan een afdrukbare versie, worden er ook PDF's beschikbaar gesteld per
practicum. De volledige PDF-versie van de cursus is te vinden via deze link. (Wordt per practicum aangevuld).
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I. P1 - Beeldinterpretatie
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2 Practicum 1: Image Download & Preprocessing

Door het combineren van de spectrale banden, kunnen verschillende kleurcomposieten worden aangemaakt, elk met
een eigen visuele doelstelling

2.1 1.1 - Doel van het practicum

In dit practicum maak je kennis met tools voor het downloaden van losse Sentinel-2 beelden en het aanmaken en
interpreteren van beeldcomposieten in QGIS. Na deze introductie gebruiken we Google Earth Engine voor verdere
beeldverwerkingsopdrachten.

2.1.1 Inhoud

Downloaden van remote sensing data:
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Data verkrijgen via:

a. ESA Sentinel Hub

b. Andere bronnen

Introductie van QGIS:

Belangrijke aspecten:

Inlezen van remote sensing beelden

Gebruik van basisfunctionaliteiten in QGIS

Aanmaken van beeldcomposieten

Beeldinterpretatie:

Analyse van beeldcomposieten

Werken met histogrammen
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3 1.2 - Het ESA Copernicus-programma

Copernicus is het aardobservatieprogramma van de EU, gericht op onze planeet en haar omgeving, ten voordele
van alle Europese burgers. Het algemene doel is het bereiken van een wereldwijde, continue, autonome,
hoogwaardige, breed inzetbare aardobservatiecapaciteit.

Onder het Copernicus-programma ontwikkelt de ESA een reeks aardobservatiemissies van de volgende generatie,
het 'Sentinel'-programma. Dit programma bestaat uit meerdere satellieten, elk gericht op een ander aspect van
aardobservatie: atmosferisch, oceanisch en landmonitoring.

Huidige Sentinel-satellieten, met hun belangrijkste doel. (Bron: ESA)

In dit practicum richten we ons op multispectrale beelden.

3.0.1 De Sentinel-2 missie
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Sentinel-2 is een missie van ESA binnen het Copernicus-programma, gericht op terrestrische waarnemingen ter
ondersteuning van diensten zoals bosmonitoring, detectie van veranderingen in landbedekking en beheer van
natuurrampen. Het bestaat uit drie identieke satellieten, Sentinel-2A, -2B en sinds september 2024 Sentinel-2C. Meer
informatie over de Sentinel-2 missie is te vinden in deze infographic.

Concreet biedt de Sentinel-2 missie:

Multispectrale gegevens met 13 banden in het zichtbare, nabij-infrarode en korte golf infrarode deel van het
spectrum.

Wereldwijde dekking van landoppervlakken van 56° Z tot 84° N, kustwateren en de Middellandse Zee.

Herhaalbezoeken elke 5 dagen onder dezelfde kijkhoeken.

Spatiale resolutie van 10m, 20m en 60m.

Een 'field of view' van 290 km.

Gratis en open data policy.

Om frequente metingen en een hoge beschikbaarheid te waarborgen, opereren de twee Sentinel-2 satellieten
gelijktijdig in een zon-synchrone baan op een hoogte van 786 km.

3.1 Sentinel-2 data downloaden

De data van Sentinel-2 is gratis beschikbaar voor het publiek. Je kunt deze eenvoudig downloaden via de Copernicus
Dataspace. Een account is vereist voor toegang.

Het dataportaal is toegankelijk via https://browser.dataspace.copernicus.eu/.

De volledige Sentinel-catalogus is ook toegankelijk via Google Earth Engine, wat in de volgende practica wordt
behandeld.
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Volg volgende stappen om een Sentinel-beeld te downloaden.

Ga naar https://browser.dataspace.copernicus.eu/

Klik op 'Open hub' om toegang te krijgen tot de interactieve grafische gebruikersinterface

Log in (of maak een account aan)

Zoom in op Belèm, een stad in het noorden van Brazilië, gelegen aan de monding van de Amazone-rivier

Teken een rechthoek rond Belèm:

Bij de tab 'Search':* Kies voor een Sentinel-2 MSI (Level 2A) beeld

Kies voor en maximale wolkbedekking van 10%

Zoek naar een afbeelding uit 2024 (Time Range)

Klik op search

Zoek naar een afbeelding die het grootste deel van de stad bevat (bekijk de afbeelding in een snel overzicht)

Download deze afbeelding naar een map op uw computer.

Ex 2.1 - Downloaden van een Sentinel-2 Level 1C-afbeelding

9/30/24, 3:07 PM Print Site - (I002450) Teledetectie practica 2024

https://users.ugent.be/~jfeyen/print_page 9/28

3.1.1 Sentinel-bestandsnaamconventie

De Sentinel-producten volgen een zogenaamde 'Compact Naming Convention':

MMM_MSIXXX_YYYYMMDDHHMMSS_Nxxyy_ROOO_Txxxxx_"Product Discriminator".SAFE

Waar:

MMM: is de missie-ID (S2A/S2B)
MSIXXX: MSIL1C duidt het productniveau Level-1C aan/ MSIL2A duidt het productniveau Level-2A aan (zie
'radiometrische correctie').
YYYYMMDDTHHMMSS: de starttijd van de gegevensinname
Nxxyy: het nummer van de verwerkingsbasislijn (bijv. N0204)
ROOO: Relatief baannummer (R001 - R143)
Txxxxx: Veldnummer
.SAFE: Productindeling (Standaardarchiefformaat voor Europa)

Een productnaam bevat 2 data. "De eerste datum (YYYYMMDDHHMMSS) vertegenwoordigt het tijdstip waarop de
gegevens zijn verzameld tijdens een sensing-operatie. De tweede datum is het "Product Discriminator"-veld, dat
bestaat uit 15 tekens. Het wordt gebruikt om onderscheid te maken tussen verschillende eindgebruikersproducten
die zijn afgeleid van dezelfde sensing-operatie. Afhankelijk van de specifieke situatie kan het tijdstip in dit veld iets
eerder of later zijn dan het werkelijke sensing-tijdstip.

Bijvoorbeeld, de volgende bestandsnaam:

‘S2A_MSIL1C_20170105T013442_N0204_R031_T53NMJ_20170105T013443.SAFE’

identificeert een Level-1C product dat is verkregen door Sentinel-2A op 5 januari 2017 om 1:34:42 uur. Het werd
verzameld over Tile 53NMJ(2) tijdens Relative Orbit 031 en verwerkt met PDGS Processing Baseline 02.04."

3.2 Andere online platformen

3.2.1 Earth Explorer

ESA heeft Sentinel-2, NASA heeft Landsat. Echter, Landsat heeft een lagere ruimtelijke resolutie van 30 m in
vergelijking met de 10 m van Sentinel-2, en Sentinel-2 heeft meer spectrale banden. Landsat-beelden worden
waarschijnlijk het meest gebruikt in wetenschappelijk onderzoek. Dit komt doordat het Landsat-programma het
langstlopende Aardobservatieprogramma ter wereld is. Landsat-1 werd al gelanceerd op 23 juli 1972. Als gevolg van
deze verschillen is Landsat op dit moment nuttiger voor historische beoordelingen van veranderingen in landgebruik
dan Sentinel-2, dat werd gelanceerd in 2015.

Landsat-gegevens zijn ook vrij toegankelijk voor het publiek. De United States Geological Survey heeft een
gegevensportaal gemaakt met uitgebreide verzamelingen EO-gegevens, waaronder Landsat-satellietbeelden, radar-
gegevens, UAS-gegevens, digitale lijngrafieken, gegevens van digitale hoogtemodellen, luchtfoto's, Sentinel-
satellietgegevens en meer.

Link: earthexplorer.usgs.gov
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4 Het Elektromagnetisch Spectrum

Het aardoppervlak weerkaatst zonlicht. Hoeveel zonlicht wordt weerkaatst, hangt af van de specifieke
eigenschappen van het betreffende aardobject. Water weerkaatst bijvoorbeeld zonlicht in het spectrum tot ongeveer
0.72 µm, maar absorbeert licht met grotere golflengtes vrijwel volledig. Elk object of landschapselement heeft een
unieke 'spectrale signatuur', waarbij het gereflecteerde zonlicht in verband staat met de golflengte. De onderstaande
figuur toont klassieke spectrale signaturen voor water, bodem en (groene) vegetatie.

Spectrale signatuur van water, vegetatie en bodem.

Vraag 2.1 - Welke golflengtes zijn niet geschikt voor het onderscheiden van bodem met groene vegetatie?
Vraag 2.2 - In welke golflengtes lijkt water zwart op de afbeelding?

Het menselijke oog is in staat om alleen golflengten waar te nemen in het bereik van 0,4 µm tot 0,7 µm, wat
overeenkomt met het zichtbare licht. Optische satellieten daarentegen kunnen gereflecteerd zonlicht detecteren over
een breder spectrum, inclusief het infrarode, ver-infrarode en thermische deel van het elektromagnetische spectrum.
De specifieke delen van het spectrum die een sensor kan detecteren, zijn afhankelijk van de sensor zelf. Elke satelliet
heeft namelijk een bepaalde spectrale gevoeligheid, ook wel aangeduid als de spectrale resolutie. Hoe gevoeliger
een sensor is voor kleine spectrale verschillen (kleine golflengte-intervallen), des te hoger is de spectrale resolutie.

4.0.1 Bandverdeling Sentinel-2

Laten we eens kijken naar enkele spectrale banden die verschillende delen van het elektromagnetisch spectrum
representeren in Sentinel-2-beelden. Een Sentinel-2-beeld bevat in totaal 13 spectrale banden met ruimtelijke
resoluties van 10, 20 of 60 meter:

Oefening: het elektromagnetisch spectrum
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Figure 1: Bandverdeling van Sentinel-2, met de centrale golflengte en ruimtelijke
resolutie per band.

Figure 2: Vergelijking van de bandverdeling tussen Sentinel-2, Landsat 8 en
Landsat 7 ten opzichte van golflengtes.

4.1 Rastervisualisatie in QGIS

We hebben al een Sentinel-2-beeld gedownload. Nu kunnen we de verschillende banden van dit beeld gaan
visualiseren met behulp van QGIS. QGIS is een open-source geografisch informatiesysteem, wat betekent dat het
gratis gedownload en gebruikt kan worden. In deze cursusgebruiken we het voornamelijk voor de visualisatie van
spectrale banden in Practicum 1, maar voor het vak Geografische Informatiesystemen (tweede semester) zal de
software verder worden verkend.
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1. Pak het gedownloade Sentinel-2-beeld uit naar een map naar keuze.

2. Open in QGIS het 'Data Source Manager'-venster om data toe te voegen: 

3. Kies voor Raster: 

4. Navigeer naar het uitgepakte .SAFE-bestand van Sentinel-2.

5. Zoek naar Sentinel-2 Band 2 met een ruimtelijke resolutie van 10 meter (> GRANULE > L2A_... > IMG_DATA >
.._B02_10m.jpg) en voeg deze band toe aan je project.

4.1.1 Identifier

Als je klikt op het 'Identify'-symbooltje , kun je individuele pixelinformatie bekijken door te klikken op je
afbeelding.

Oefening: het openen van Sentinel-2 rasterbanden in QGIS
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Vraag 2.4 - Vergelijk de pixelwaarde binnen band 2 van een wolkpixel en een waterpixel. Wat betekent dit?

4.1.2 Histogram

Een histogram is een grafische weergave van statistieken met betrekking tot de helderheid van een afbeelding. Het
toont de verdeling van grijswaarden binnen een afbeelding. Op de verticale as wordt de frequentie van specifieke
grijswaarden binnen de afbeelding weergegeven.

Om het histogram van een band in QGIS te laden: 1. Klik met de rechtermuisknop op de afbeelding in het 'Layers'-
paneel. 2. Kies Properties om een nieuw venster te openen. 3. Ga naar het tabblad 'Histogram'. 4. Klik op Compute
Histogram om het histogram te genereren.

Vraag 2.3 - Wat zijn de minimum- en maximumwaarden van de huidige visualisatie?
Vraag 2.4 - In welk bereik van pixelwaarden bevinden de meeste pixels in de afbeelding zich?

Oefening: het elektromagnetisch spectrum

Histogram
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4.1.3 Image Stretching (contrastverhoging)

Beeldstretching is een techniek die tot doel heeft het contrast tussen de pixels in een afbeelding te verbeteren door
ze uit te rekken naar een nieuwe reeks intensiteitswaarden. De keuze van deze reeks is afhankelijk van de objecten
op de grond die meer detail nodig hebben of waar de focus op ligt.

Het beeld dat we momenteel hebben gevisualiseerd lijkt vrij donker, waarbij alleen de witte wolken duidelijk zichtbaar
zijn. Dit komt doordat de reflectiewaarden van wolken veel hoger liggen dan die van andere landbedekkingsklassen
(zoals te zien is in de identifier en het histogram).

Huidige Sentinel-satellieten, met hun belangrijkste doel. (Bron: ESA)

Er zijn twee methoden om beeldstretching uit te voeren in QGIS:

Optie 1: via het histogram Door de min-/max-grenzen van de visualisatie aan te passen in het histogramvenster,
kun je beeldstretching uitvoeren. Dit kan visueel worden gedaan door het bereik te selecteren waarin de meeste
pixels vallen.

Optie 2: via de rasterwerkbalk Een handige tool is de Rasterwerkbalk, waarmee je stretching kunt uitvoeren op
basis van je huidige vensterview. Deze werkbalk is standaard niet zichtbaar, maar kan worden toegevoegd via
View > Toolbars > Rasterwerkbalk. Beweeg met je muis over de verschillende knoppen om te zien wat ze doen en
probeer ze uit.

4.2 Spectrale banden Sentinel-2
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Hieronder vind je een beschrijving van de eigenschappen en het gebruik van elke spectrale band van Sentinel-2.
Visualiseer alle banden en probeer verschillende landschapselementen te identificeren in elk van de banden.

Band 2 - Blauw - Resolutie 10 m
Band 2 is geschikt voor het onderscheiden van bodem en vegetatie, het in kaart brengen van bossoorten en het
identificeren van door de mens gemaakte objecten. Het wordt verstrooid door de atmosfeer, verlicht materialen in
schaduwen beter dan langere golflengtes en dringt helder water beter binnen dan andere kleuren. Het wordt
geabsorbeerd door chlorofyl, wat resulteert in donkerdere planten.

Band 3 - Groen - Resolutie 10 m Deze band biedt uitstekend contrast tussen helder en troebel water en dringt
goed door in helder water. Het helpt bij het markeren van olie op wateroppervlakken en vegetatie. Groen licht
wordt sterker gereflecteerd dan enige andere zichtbare kleur. Door de mens gemaakte objecten zijn nog steeds
zichtbaar.

Band 5/6/7 - Red-edge - Resolutie 20 m Voor de classificatie van vegetatie. Gevoelig voor de 'red-edge zone, wat
de zone is waar de reflectie van vegetatie zeer snel stijgt binnen het elektomagnetisch spectrum.

Band 8 - NIR - Resolutie 10 m De nabij-infrarode band is geschikt voor het in kaart brengen van kustlijnen en de
inhoud van biomassa, evenals het detecteren en analyseren van vegetatie.

Band 8 - narrow NIR - Resolutie 20 m De smalle nabij-infrarode band is een kleiner deel van het NIR-bereik en
komt nauw overeen met het NIR-bereik van Landsat-8.

Band 9 - Water Vapour- Resolutie 60 m Deze band is geschikt voor het detecteren van waterdamp.

Band 10 - SWIR Cirrus - Resolutie 60 m Voor de detectie van cirruswolken.

Band 11 - SWIR 1 - Resolutie 20 m Deze band is handig voor het meten van vochtgehalte in de grond en
vegetatie, en biedt een goed contrast tussen verschillende soorten vegetatie. Het helpt bij het onderscheiden van
sneeuw en wolken, maar heeft beperkte doordringbaarheid voor wolken.

Band 12 - SWIR 2 - Resolutie 20 m Deze band is handig voor het meten van vochtgehalte in de grond en
vegetatie, en biedt een goed contrast tussen verschillende soorten vegetatie. Het helpt bij het onderscheiden van
sneeuw en wolken, maar heeft beperkte doordringbaarheid voor wolken.

4.3 Oefening - Bandverdeling Landsat 8

Link de verschillende Landsat-8 banden (in grijswaarden) met de overeenstemmende banden (zonder panchromatische
band). Bekijk hiervoor de tabel met de Landsat-8 bandverdelingen het elektromagnetisch spectrum hierboven.

Het gebied is de 'Greater Dublin Area', wat aldus de grotere zone ron Dublin omhelst.

Analyse: Spectrale banden Sentinel-2

Oefening - Landsat 8 bandverdeling
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Figure 3: A
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Figure 4: B

Figure 5: C
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Figure 6: D

Figure 7: E
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Figure 8: F

Figure 9: G
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5 1.4 - Kleurcomposieten

Door combineren van verschillende banden tot één enkel beeld, kunnen beeldkenmerken duidelijk worden die
daarvoor moeilijk te onderscheiden waren. Een beeld bestaat typisch uit 3 kleurbanden: de blauwe, groene en rode
band. In een ware of normale kleurencomposiet (‘true color composite’) is het simpel: hier worden de blauwe,
groene en rode band aan de overeenkomstige kleurbanden toegekend. Het resulterende beeld stemt dan overeen
met hetgeen het menselijke oog waarneemt.

Een ander veelgebruikte composiet is de valse kleuren composiet (‘false colour composite’), waarbij de groene, rode
en infrarode band worden toegekend aan respectievelijk de blauwe, groene en rode kleur. In dit beeld krijgt vegetatie
een rode kleur aangezien het een sterke reflectie kent binnen de NIR-band. Water krijgt een blauwe kleur, aangezien
het sterk gereflecteerd wordt in de groene band (en meer wordt geabsorbeerd in rode/infrarood).
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5.1 Aanmaken van een composiet in QGIS

Laat ons een eigen beeldcomposiet aanmaken in QGIS! Hiervoor laad je eerst de andere banden ook in je project.
Klik daarna op het menu-item 'Raster'> 'Miscellaneous' > 'Build Virtual Raster'

Een nieuw scherm wordt getoond, waarbij je de keuze krijgt om banden toe te voegen. Kies hierbij voor de 3 banden
waarvoor je een beeldcomposiet wenst te maken (bijvoorbeeld Band 8 (NIR), Band 4(Rood), Band 3 (Groen) bij het
maken van een Valse Kleurencomposiet). De volgorde van de banden is hierbij van belang, deze kun je nog verslepen
bij het toevoegen). Kies daarnaast ook om je inputbanden elk in een afzonderlijke band te plaatsen (anders wordt
een gemiddelde waarde berekend), en de Resolutie naar 'Highest' te veranderen. Dit zorgt er voor - mocht je
composieten met banden van verschillende resoluties willen aanmaken (bv 10m samen met 20m) - de banden ook
'geresampled' worden.
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Resampling is het aanpassen van de spatiale resolutie van een rasterbeeld. Hiermee kan bijvoorbeeld een spectrale
band met resolutie van 20m worden omgezet naar 10m, zodat deze kan gecombineerd worden met een band van 10m
resolutie. Het verhogen van de spatiale resolutie is upsampling, terwijl het verlagen van de spatiale resolutie
downsampling wordt genoemd.

Principe van resampling. Boven: upsampling (via 'nearest neighbor'). Onder: Downsampling (via 'minimum').

Na het laten lopen van de tool, wordt een nieuwe laag binnen QGIS aangemaakt; de composiet (als een virtuele laag).
Helaas behouden de banden hun naam niet binnen de nieuw aangemaakte virtuele raster, waardoor de volgorde van
toevoegen van belang. Automatisch wordt de bovenste laag in het lijstje 'Band 1' binnen de composiet. Houd dit dus
goed bij bij het aanmaken van composieten!

Info - Resampling
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De toekenning van banden aan de 3 kleurbanden, zijn wel te wijzigen. Klik hiervoor met je rechtermuis op de Virtual
Layer > Properties > Symbology. Pas hierbij de banden aan om ook de composiet te wijzigen.

Test ook enkele andere typische Sentinel-2 composieten (Red, Green, Blue):

Natural Colour: 4 3 2

False colour Infrared: 8 4 3

False colour Urban: 12 11 4

Agriculture: 11 8 2

Atmospheric penetration: 12 11 8a

Healthy vegetation: 8 11 2

Land/Water: 8 11 4

Natural Colours with Atmospheric Removal: **12 8 3 **

Shortwave Infrared: 12 8 4

Vegetation Analysis: 11 8 4

5.2 Beeldcomposieten: oefeningen
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Gegeven zijn 4 verschillende kleurencomposieten van hetzelfde beeld. Met welke bandcombinaties zou je deze kunnen
verbinden?

Kleur => Banden (R,G,B) Beeld

R,G,B => 3,2,1

R,G,B => 3,4,5

R,G,B => 4,3,2

R,G,B => 5,4,3

Oefening 1 - Mackenzie River
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Mackenzie River, N.W.T., LANDSAT TM. Figuur C: bossen zijn rood, de donkerder bruine gebieden in het midden van het
gebied zijn stukken afgebrand bos. De witte gedeelten zijn bergtoppen bedekt met sneeuw.

Oplossing komt na dit practicum online ;)

Oplossing
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Gegeven zijn 4 verschillende kleurencomposieten van hetzelfde Landsat-8 beeld. Met welke bandcombinaties zou je
deze kunnen verbinden?

Kleur => Banden (R,G,B) Beeld

R,G,B => 5,4,3

R,G,B => 6,5,4

R,G,B => 5,6,2

R,G,B => 4,3,2

Oefening 2 - Roermond
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Roermond, Landsat 8 OLI.

Oplossing komt na dit practicum online ;)

Oplossing
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